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[bookmark: _Toc208162199]Introduction
Kanban Task Manager for SharePoint helps a workgroup cooperate on projects and tasks in SharePoint. The software visualizes the workflow and makes it easy to manage projects. 
The traditional wooden kanban board uses paper cards that tell what and how much should be produced and when it should be done. When managers get such a visual overview of the work process and status, they can quickly reveal bottlenecks and blockers. Less time is spent on trying to sort out how projects are coming along, because everything is visible on the kanban board.
With Kanban Task Manager, you can show tasks from a Tasks list on a kanban board in SharePoint and get many more features than you have on the physical kanban board. 
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Working in kanban style with tasks in SharePoint gives you everything on a screen. On top of that, the kalmstrom.com developers have added many useful features:
Drag and drop tasks within or between phases and lanes 
Filter tasks by project(s), responsible(s) and/or priority/priorities and if enabled also by a custom value
Search of task subjects and body texts
Automatic synchronization of tasks within the workgroup, so everything is always up to date and everyone can see what is happening.
Display of tasks for multiple projects in one kanban board
Possibility to create swim lanes
WIP limits gives a warning when there are too many tasks in a phase or a swim lane
Extra field for a custom parameter to select in the task form
% completed bar that shows task progress
Priority icons on tasks
Task overdue indicator
Assigned person's image on the task if added in the system
Set number of columns per phase
Create a Checklist for each task
Display the checklist count on the task cards
Time Logging to keep track of invested time per task
Grid view to see and edit all the tasks in an Excel-like way
7 Habits view to display open tasks in four quadrants based on importance and urgency
Switch between Tasks lists to display on the kanban board.
Both editions of Kanban Task Manager are used inside a site. Any new additions of Kanban Task Manager will use the same tasks and settings lists as the first one, no matter which edition it is.
Chapter 2 of this manual is intended for all users, while the rest is intended for Kanban Task Manager administrators. 
The screenshots in this manual show the Kanban Task Manager example data. These can be generated by evaluators who wish to study Kanban Task Manager without using live data or creating test examples, refer to chapter 4. 
[bookmark: _Toc208162200]Language
The SharePoint language will automatically be used for Kanban Task Manager. The supported languages are Arabic, Danish, Dutch, English, French, Italian, Norwegian, Portuguese, Spanish and Swedish. If the SharePoint language is not supported, English will be used instead.
[bookmark: _Toc266799434][bookmark: _Toc208162201]Requirements
[bookmark: _Toc266799436]To use Kanban Task Manager, you need to have SharePoint 2013 or above (in-house or hosted) or Microsoft/Office 365 SharePoint Online. Tested browsers are Microsoft Edge and the latest versions of Google Chrome and Mozilla Firefox.
[bookmark: _Toc40895310][bookmark: _Toc201399039][bookmark: _Toc202782835][bookmark: _Toc208162202]Editions
Kanban Task Manager comes in two editions, SPFX edition and Sandboxed solution, and in three different packages. They are installed in different ways, but they have the same version numbers and features. One subscription is valid for all packages, so you can use any combination you wish. 
[bookmark: _Toc201399040][bookmark: _Toc202782836][bookmark: _Toc208162203]The SPFX edition
The Kanban Task Manager SPFX edition supports SharePoint 2016, 2019, SE and Online. 
[bookmark: _Toc201399041][bookmark: _Toc202782837]The SPFX edition is very easy to install and upgrade, so we recommend that you use it when possible. It gives a web part that can be added to classic as well as modern SharePoint pages, and a modern page with the Kanban Task Manager web part can be added to a Teams tab.
[bookmark: _Toc208162204]The Sandboxed Solution
The Kanban Task Manager Sandboxed SharePoint solution gives a Kanban Task Manager page in each site where it is installed. It supports SharePoint 2013, 2016, 2019, SE and Online and comes in two packages, a WSP file for manual installation and a PowerShell script for quick installation in multiple sites. 


[bookmark: _Toc201399044][bookmark: _Toc202782838][bookmark: _Toc208162205]Permissions
Standard SharePoint permissions are used for Kanban Task Manager. 
[bookmark: _Toc201399046][bookmark: _Toc202782839][bookmark: _Toc208162206]Use Kanban Task Manager
Users must have at least Contribute permission on the list to book resources. In SharePoint Online, this generally means Edit permission. To view tasks, only Read permission is necessary. 
To manage the Kanban Task Manager settings, you need to have Edit permission on the site where Kanban Task Manager is installed. 
[bookmark: _Toc201399048][bookmark: _Toc202782840][bookmark: _Toc208162207]Install the SPFX edition
To upload the Kanban Task Manager SPPKG file to an App catalog, you need to be a Global or SharePoint Admin of your tenant or farm. Deployment to all sites can be done in the same process. 
If Kanban Task Manager is not enabled for all SharePoint Online sites in the upload process, it can be deployed in a single site by the Site owner. 
[bookmark: _Toc201399049][bookmark: _Toc202782841][bookmark: _Toc208162208]Install the Sandboxed Solution Manually
To upload the Kanban Task Manager Sandboxed solution to the Solutions gallery, you need to be Site admin. To activate the solution for the site, you must be at least Site owner. Often, but not always, the same people have both these permissions.
[bookmark: _Toc201399050][bookmark: _Toc202782842][bookmark: _Toc208162209]Install the Sandboxed Solution with a PowerShell Script
You need to be a SharePoint Admin of the farm or tenant to run the PowerShell script that installs Kanban Task Manager in all sites included in the script.
[bookmark: _Toc202782843][bookmark: _Toc208162210]Third Party JavaScript Libraries
The kalmstrom.com team has modified and extended two third-party JavaScript libraries to create Kanban Task Manager: jQuery and JQWidgets. No extra license is necessary to use these libraries in Kanban Task Manager. 
[bookmark: _Toc208162211]Make Homepage
If you want to use a dedicated site for project cooperation, it is suitable to make the Kanban Task Manager page the homepage of that site. 
To do that with the Sandboxed Solution, open the PAGE tab in the ribbon and click on the Make Homepage button.
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For the SPFX edition, open the Site contents >Site pages and find the page where you added the Kanban Task Manager web part. Select the page and right-click on the ellipsis and choose Make homepage. The same command is also found under the ellipsis in the command bar.
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[bookmark: _Hlk206598781]Another option for the SPFX edition is of course to add the Kanban Task Manager web part on the default homepage directly, or to add a page with the web part to a Teams tab.
[bookmark: _Toc208162212]Multiple Tasks Lists
One Tasks list called "KTM Tasks" is created automatically when Kanban Task Manager has been installed and is opened for the first time, but a site can very well have multiple Tasks lists.
The Tasks list is a classic list that that can be reached from:
the Site contents or Home page >New >App >classic experience
the settings icon >Add an app >classic experience
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the Site contents >Return to classic experience >Add an app
(Search for and) click on the Tasks list tile to create a new Tasks list. All adaptations to Kanban Task Manager will be performed the first time you select the new list from the View dropdown, refer to 2.4.1. Each Tasks list has its own settings.
If you use multiple Tasks lists in the same site, it might be suitable to rename the KTM Tasks list. Open the List settings from the LIST tab in the ribbon or by right-clicking on the list in the Site contents and select 'List name, description and navigation' to rename the list.
[bookmark: _Ref169262664]One site for each Kanban Task Manager page might be the best for scenarios where different people manage different kind of tasks, for example one site for each workgroup. Managers can have access to all sites, while the workgroup staff only needs to access their own site. 
Multiple Tasks lists in one site is better if the same group of people manage various kinds of tasks and when managers want to quickly get an overview of work progress without opening multiple sites.
[bookmark: _Toc354151869][bookmark: _Toc7436884][bookmark: _Toc136005848][bookmark: _Toc208162213]Use Kanban Task Manager
This chapter contains information that all Kanban Task Manager users should be familiar with. If the Sandboxed solution is used, Kanban Task Manager is displayed in a page created when Kanban Task Manager is activated on a site. The SPFX edition gives a web part that displays the same Kanban Task Manager. The Kanban Task Manager web part can be added to any modern or classic SharePoint page.
[bookmark: _Ref166771605]Kanban Task Manager can be customized in various ways, so it is possible that your installation does not have all options activated. However, here we will describe how the product works when all features are activated and the default tasks list is used without any changes.
Kanban Task Manager has multiple views, but the default view displays the kanban board and that is probably where most users will work.
[bookmark: _Toc136005870][bookmark: _Toc208162214]Views
Apart from the default kanban view, Kanban Task Manager has two more views where you can study the tasks. Select your preferred view from the View dropdown above the current view. 
At the bottom of the View selector, you can also select another Tasks list to show in Kanban Task Manager, if multiple such lists have been created in the site, see 2.8. below. 
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[bookmark: _Toc7436885][bookmark: _Toc136005849][bookmark: _Toc208162215]Kanban View
The Kanban view displays the items in a Tasks list as cards on a kanban board. The task cards are grouped in phases according to their status value. By default, all items in the list are shown on the board. 
The kanban board may also have different lanes. Click on the lane's name banner if you want to collapse a lane. Click again to expand it.
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You can use the Ctrl key + the plus or minus key to zoom in and out on the kanban board, just like with any web page. 
[bookmark: _Toc136005875][bookmark: _Toc208162216]Grid View
In the grid view, you can see all information about all tasks. 
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You can also work with the tasks in various ways:
Double-click on the column headers to sort the data ascending or descending. 
Double-click on cells in all columns but Subject and Assigned To, to filter the column values. 
Click on a cell in the Assigned To column to change the value.
[image: ]
Select multiple cells by Shift + arrow keys to copy, paste or fill down values.
[image: ]
You can also use the Grid view to copy and paste information about the current task load to other applications.
[bookmark: _Toc7436927][bookmark: _Toc136005874][bookmark: _Toc208162217]7 Habits View
The 7 Habits view is inspired by the highly popular book "The 7 Habits of Highly Effective People" by Stephen Covey. The book and the view make it easier for users to understand which tasks are most important and urgent and encourage the users to focus on those tasks first. 
The 7 Habits view displays the open tasks in four quadrants: Urgent-Important, Urgent-Not Important, Not Urgent-Important and Not Urgent-Not Important.
The importance depends on the task's priority, while the urgency depends on the task's due date. 
Quadrant 1: Urgent-Important
High priority tasks that are overdue or due today, will be displayed in the first quadrant. When a task is moved to this quadrant, the priority will automatically be set to High. The due date will be set to the current date. These tasks should be taken care of immediately.
Quadrant 2: Not Urgent-Important
High priority tasks that are not due today, will be displayed in the third quadrant. When a task is moved to this quadrant, priority will automatically be set to High. One more day will be added to the due date if it is the current date. If the due date is a later date, it will remain unchanged. These tasks should be scheduled.
Quadrant 3: Urgent-Not Important
Low or normal priority tasks that are overdue or due today, will be displayed in the second quadrant. When a task is moved to this quadrant, the priority will automatically be set to Normal and the due date will be set to the current date. If the task is urgent but not important, you should consider if it can be automated or delegated.
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Quadrant 4: Not Urgent-Not Important
Low or normal priority tasks that are not due today, will be displayed in the fourth quadrant. When a task is moved to this quadrant, the priority will automatically be set to Normal and one more day will be added to the due date if it is the current date. If the due date is a later date, it will remain unchanged. Ideally, there should be no tasks in this quadrant, because if tasks are neither urgent nor important you might ask if they need to be performed at all.
At the top left corner of the view, you can see the total number of open tasks displayed in the view. In the center of the view, you can see the total number of tasks in each quadrant.
[bookmark: _Toc136005850][bookmark: _Toc208162218]The Task Card
In the two Kanban Task Manager views Kanban and 7 Habits, the items in the Tasks list are visualized as cards. Each card is color coded, by either project or assigned, and the colored field has information about progress and a checklist count if that is used. The task name is visible above the colored field, and the task cards also contain some other crucial information.
[bookmark: _Toc7436895][bookmark: _Toc136005851][bookmark: _Toc208162219]Priority
When you set the priority of a task to something else than the default Normal, the task card will have an importance icon. 
High priority tasks have red exclamation marks and low priority tasks have blue downward arrows. Tasks with normal priority do not show a Priority icon. 
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[bookmark: _Toc136005852][bookmark: _Toc208162220][image: A pink and blue rectangle with black text

AI-generated content may be incorrect.] Due Date / Extra Parameter
If no extra field is used for Kanban Task Manager, the due date will be displayed below the colored band in the task card, see the images above. When an extra parameter is used, the tasks value for the extra field is displayed instead.
[bookmark: _Toc208162221]Project
[image: A blue and purple rectangle with text

AI-generated content may be incorrect.] When a project or similar can be selected in the task form, the name of that project is visible below the colored band in the task card, and then due date or extra parameter is moved down. 
[bookmark: _Toc7436896][bookmark: _Toc136005853][bookmark: _Toc208162222][image: A purple and black text

AI-generated content may be incorrect.]Task Overdue Indicators
When a task is overdue, this will be indicated by a red border. The due date or extra field value on the card is also displayed in red.
[bookmark: _Toc136005854][bookmark: _Toc208162223][bookmark: _Hlk526352575]Assigned 
The person that the task has been assigned to is displayed with a photo on the task card. If no photo has been added to the SharePoint account, the image icon will have the responsible person's initials. 
Tasks that have not yet been assigned, have a U on the image icon. If multiple assignees is allowed in the Task list, a multiheaded icon is shown on tasks with multiple assigned people.
[bookmark: _Toc354151875][bookmark: _Toc7436893][bookmark: _Toc136005855][bookmark: _Toc208162224]Move Task Cards
You can drag the task cards within a phase, from one phase to another, from one lane to another or from one quadrant to another. Move the cursor over the task, and when the cursor transforms into a hand you can drag the card and drop it in the new place.
If you have a touch screen, you can move the cards with a finger. 
When you move the task card to another phase, lane, the phase/lane info in the task will be changed automatically. When you move a task card between quadrants, the specific quadrant parameters will be modified in the same way.
[bookmark: _Toc208162225]Work with the Task Form
The image below shows the biggest possible Kanban Task Manager form, when checklist and time logging have been activated and a custom parameter (Type), Lanes, Projects and Actions are used. The task form in your installation might be considerably simpler if all these optional features are not used.
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Save your changes with the Save button in the bottom right corner of the task form. The page will be refreshed automatically, so that you can see any modification immediately.
[bookmark: _Toc7436891][bookmark: _Toc136005863][bookmark: _Toc208162226]Create a New Task
There are multiple ways to create a new task:
1. Double-click in an empty space in the Kanban view. This will create a new task in the phase and lane where you double-clicked.
1. Double-click in a quadrant in the 7-Habits view. This will create a new task in the quadrant where you double-clicked, and it will have the typical parameter values for that quadrant.
Click on the plus sign above the view or press CTRL + Enter on the keyboard. This will create a new task in the first lane and first phase or in the fourth quadrant.
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In these cases, the Kanban Task Manager task form will open in edit mode. 
You can also type in the task details in the Grid view. In that case a task card with those parameter values will be created.
[bookmark: _Toc208162227]Edit an Existing Task
Double-click on a task card to open the task in edit mode. You can also right click on the task card and select Edit.
[bookmark: _Toc208162228]Task Parameters
In the Kanban Task Manager task form, you can select values for various task parameters.  These values are fetched from the settings. 
[bookmark: _Toc208162229][bookmark: _Toc136005864]Priority
To the right of the Task name field is a Priority area. It is blank in the image above, which means Normal priority. If you click once in this area the task priority is set to Low. Click twice to set the priority to High. 
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When you click a third time, the priority value is set back to Normal, and the area becomes blank again.
[bookmark: _Toc208162230]% Complete
In the Kanban Task Manager task form, you can set the completed value by clicking on the percentage icon to the right of the Status field. 
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If you set the % Complete, the value will be shown as a line at the bottom of the color field on the task card. 
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When you set the % Complete to 100, the Task Status value will change to Completed, and when you save the task form the card will be moved to the Completed phase.
Note: the automatic changes of Task Status value follow the sequence order set in the Kanban Task Manager Configuration, not the actual phase names. Therefore, these automatic changes should work well even if your status names are changed into something else.
[bookmark: _Toc208162231]Assigned To
By default, the dropdown where you select the person or group who should work with the task is called Assigned To, but this can be changed, so your organization might use another caption, for example Responsible.
By default, multiple choices are allowed and the dropdown has checkboxes at the names, as in the image below. Check the box(es) for at the name(s) you want to assign to the task and click OK.
If multiple choices are not allowed, there are no checkboxes and no OK button to press. You just select a name, and the dropdown will be closed. 
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When the task was unassigned and you assign the task to someone, the Unassigned box at the bottom of the list will be unchecked automatically.
If you switch to the SharePoint form, you can add new people by writing the first letters of the assignee name in the Assigned To field. Then SharePoint will suggest names from the user accounts. When you save the task, the new name will be added to the settings and can be selected in the Kanban Task Manager form.
[bookmark: _Toc208162232]Start and Due Dates
Open the Date picker to set start and due dates for the task. You can also type in the dates. The weekday name abbreviation is set automatically by Kanban Task Manager.
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[bookmark: _Toc7436897][bookmark: _Toc136005868][bookmark: _Toc208162233]Checklist
[image: A close-up of a message

AI-generated content may be incorrect.]To make it easier to work with extensive tasks, you can add a checklist to it. You can manage the checklist in the Kanban Task Manager form, while creating or editing a task. The finished steps are displayed on the task card. 
Write a step in the field and press Enter on the keyboard. Now a new entry will be added below the field. Check the entry when that part of the task is finished. 
This feature can only be entered in the Kanban Task Manager form, but it can be seen in the SharePoint form too and the values can be deleted.
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[bookmark: _Toc7436901][bookmark: _Toc136005869][bookmark: _Toc208162234]Time Logging
Keep track of how long you have worked on a task with the help of time logging. You can manage the time logging in the task form, while creating or editing a task. Add the number of minutes you have worked with the task and press Enter or go to the next cell. Now, the date and your name will be added automatically.
When several people work on a task, each of them should add their minutes in the form if the feature is used.
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This feature can only be entered in the Kanban Task Manager form, but it can be seen in the SharePoint form too and the values can be deleted.
[bookmark: _Toc136005857][bookmark: _Toc208162235]Commands in Context Menu and Task Form
When you right-click on a card on the kanban board, you can manage the task in various ways. Use the Edit command if you want to open the Kanban Task Manager form.
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The same commands except Edit can be found in the Kanban Task Manager task form. The form always open in Edit mode. Use Save to save your changes and close the task form and Cancel to discard them and close the task form.
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The last command in the context menu, here Needs research, refers to an Action, see below.  Kanban Task Manager can have multiple such actions, and they can also be selected in a dropdown in the task form.
[bookmark: _Toc136005858][bookmark: _Toc208162236]Edit in SharePoint Form
When you select SharePoint in the task form or context menu, the task will open in the standard SharePoint task form instead of the Kanban Task Manager form. Here, you can upload images from your computer to the task.
[bookmark: _Toc136005859][bookmark: _Toc208162237]Copy 
When you copy a task, a new task will open. It will have the same data as the original task, but the % Complete value will be set to 0 % and any time logging and checklists will be empty. Make any changes you wish and then save the copy. 
If you use the Copy command in the task form, the original task will close and the new task will open instead. Any changes to the original task will be lost.
[bookmark: _Toc7436894][bookmark: _Toc136005860][bookmark: _Toc208162238]Remove a Task
You can delete a task with the Remove button in the open task dialog. Just like other deleted SharePoint items, the deleted tasks will be moved to the sites recycle bin, where they are usually kept for 30 days. This makes it easy to restore deleted tasks. 
[bookmark: _Toc136005861][bookmark: _Toc208162239]Comment
When you use the Comment command in the context menu, a dialog will open where you can enter your comment without opening the task. 
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The comment will be added to a comment field in the task description, below any description text (and earlier comments).
When you click on the comment button in the Kanban Task Manager task form, you can enter your comment directly in the field below the description (and any earlier comments). 
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In both cases, each new comment will have its own comment field in the task description. The person who made the comment and the time it was entered will be added automatically.
[bookmark: _Toc136005862][bookmark: _Toc208162240]Actions
When you choose an action, one or more task properties will be changed automatically when you save the task. The action might also save and close the task. If actions are used, you can find them at the bottom of the context menu and in the dropdown at the bottom of in the Kanban Task Manager task form.
The Kanban Task Manager administrator decides in the Kanban Task Manager settings how the various actions should affect the tasks. If that is done correctly and the actions have suitable names, you don't as a user need to know exactly which the changes are.
[bookmark: _Toc37166464][bookmark: _Toc136005880][bookmark: _Toc208162241]Filter and Search Tasks
Click on the Search icon to open the left panel. 
Here you can filter tasks by project(s), assigned and/or priority/priorities. If your installation uses a custom field, you can filter on those values too. In the image below, that field is called Branch.
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To search, type a word or phrase in the search field and press Enter or click on the Search icon. Kanban Task Manager will search and show tasks that contain the word or phrase, and the rest of the tasks will be hidden. 
Refresh the page to reset the view. This search and filter feature work on all views.
[bookmark: _Toc208162242][bookmark: _Toc354151880][bookmark: _Hlk2272030][bookmark: _Hlk526352861][bookmark: _Hlk38212827]Multiple Tasks Lists
One Tasks list is created automatically when Kanban Task Manager is installed, but a site can very well have multiple such lists. When additional Tasks lists are created in a site, Kanban Task Manager will pick up these sites and the View dropdown will get a extra entry for each Tasks list. The name of the current list is displayed to the right of the counter above the view. Switch list by clicking on the list in the View dropdown.
[image: A screenshot of a computer
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Kanban Task Manager will remember which task list you used last time, so that the same list will be shown when you open Kanban Task Manager again.
[bookmark: _Toc201399051][bookmark: _Toc202782844][bookmark: _Toc208162243]Installation Details
Within Microsofts limitations we have tried to make our products as easy as possible to install. The installation files can be downloaded from the kalmstrom.com website. Download pages for all packages can be reached from https://www.kalmstrom.com/products/TaskManager/DownloadSP.htm. The download pages have videos that show the installation process.
You can also find all installation demonstrations on the Kanban Task Manager Demonstrations page at https://www.kalmstrom.com/products/TaskManager/DemonstrationsSP.htm. 
Another option is to use the kalmstrom.com installation service, please refer to: https://www.kalmstrom.com/Services/Installation-Assistance.htm.
[bookmark: _Toc208162244]The Tasks List
The first time you open Kanban Task Manager on a site, a KTM Tasks list will be created. If there is an existing Tasks list in the site, Kanban Task Manager will use that list instead, and no KTM Tasks list will be created.
[bookmark: _Toc208162245]The SPFX edition
The Kanban Task Manager SPFX edition gives a modern client-side web part that can be added to modern as well as classic SharePoint pages. It comes as an SPPKG file that is downloaded in .zip format from the kalmstrom.com website to your PC and then extracted and uploaded to the App catalog in the tenant or farm. 
There are two download files, one for SharePoint Online and one for SharePoint On-Premises.
[bookmark: _Toc208162246][bookmark: _Toc40895325][bookmark: _Hlk200992278]SharePoint Online
Go to the tenants App catalog/Apps site. (If you have not already created such a site, it will be created the first time you click on the Open button in the SharePoint Admin center >More features >Apps.) 
Upload the SPPKG file. (If there is a warning message for add-ins, it can be ignored. It does not apply to SPPKG files.)
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A right Enable app pane opens. Select one of the options:
Enable the file.
Enable the file and add Kanban Task Manager to all sites. This option is default and makes it possible to use the Kanban Task Manager web part in pages in the whole tenant. 
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Click on the Enable app button.
Close the right pane.
If you have used the default option and added Kanban Task Manager to all sites, you can now stop adding Kanban Task Manager to new sites. 
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If you instead have chosen to not add Kanban Task Manager for all sites, you will have a command that adds Kanban Task Manager to all sites.
[bookmark: _Toc201399054][bookmark: _Toc208162247]Deploy in a Site
If you have selected to only enable the file but not add it to all sites, Site owners must deploy Kanban Task Manager manually in each site where it should be used. 
1. In the site where you want to use Kanban Task Manager, click on + New >App in the modern homepage or Site contents, or click on the settings icon in the top navigation bar and select Add an app.
Select "All" or "From your organization" in the left menu.
Click on the Kanban Task Manager tile.
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Click on the Add button.
[image: A screenshot of a computer
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Now Kanban Task Manager will be installed in the current site, and the Kanban Task Manager web part can be added to pages in that site.
Repeat the process for each site where you want to use the Kanban Task Manager web part. 
[bookmark: _Toc208162248]SharePoint On-Premises
Microsoft has created the SPFX edition for SharePoint Online, but the kalmstrom.com team has managed to get it to work for SharePoint On-Premises too. 

We can however not change the text in Microsoft´s "Deploy" dialog, so it might look confusing for on-premises users to see "SharePoint Online" there, as in the image at step 3 below. Dont worry, you will get a Kanban Task Manager web part that works on all pages in SharePoint 2016, 2019 and SE.
1. Go to the SharePoint farms App catalog >Apps for SharePoint and upload the SPPKG file.
1. A dialog opens. Check the box at Make this solution available to all sites in the organization.
1. Click on Deploy.
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Now the Kanban Task Manager web part is available in all pages in the farm.
[bookmark: _Toc208162249][bookmark: _Toc201399055][bookmark: _Toc202782847]Add the Web Part to a Page
[bookmark: _Hlk207038665]The Kanban Task Manager web part is found among the other web parts when you edit a page. In classic pages, Kanban Task Manager is found in the kalmstrom.com category. In modern pages, you can find it under Advanced or search for it. 
We recommend that you use a one column or full-width section, remove the default comments section in modern pages and not add any additional web parts to this page.  
[image: A screenshot of a computer
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[bookmark: _Hlk206858003]The Kanban Task Manager kanban board will not be visible until you have published and refreshed the page. In a classic page, you might need to make a hard refresh with Ctrl+Shift+R to make it appear after publication. 
[bookmark: _Toc208162250]Add to Teams
To use Kanban Task Manager in Microsoft Teams, add a modern page with the Kanban Task Manager web part to a new Teams tab. 
1. Create a new modern page. You can start in SharePoint or open the Shared tab in the Teams channel you wish to use and go to SharePoint from the link under the ellipsis.
a. Give the page a name – it will be visible on the Teams tab.
b. Publish the page.
2. Add a new SharePoint Page tab to the Teams channel.
3. Select the page you created or paste the page link.
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The process is described in a demo at https://www.kalmstrom.com/products/TaskManager/DemonstrationsSP.htm.
[bookmark: _Toc201399056][bookmark: _Toc202782848][bookmark: _Toc208162251][bookmark: _Toc354151858][bookmark: _Toc201399061]Sandboxed Solution
The Kanban Task Manager Sandboxed solution is uploaded to a sites SharePoint Solutions gallery. It adds a site feature to the site, and this feature needs to be activated for the site and any subsites where it will be used. The upload and activation can be done manually or with a PowerShell script.
When the Kanban Task Manager feature has been activated, a Kanban Task Manager link will be added to the Web Designer Galleries group in the Site settings. Click on this link to get started, refer to 3.3.
[image: ]
[bookmark: _Toc208162252]Site Assets
When the Kanban Task Manager feature is activated for a site, two files will be created in the Site Assets library of that site: a JavaScript file, KTM.js and a SharePoint page with the Kanban Task Manager kanban board, KTM.aspx. Another page, KTMSettings.aspx, will be created in the Site Assets the first time you save the Kanban Task Manager settings. 
Before you start the installation, you must therefore make sure that the site really has a Site Assets library. If there is no such library, activate the Wiki Page Home Page feature under Site settings >Site actions >Manage site features, to create the library. (Your homepage will not be affected by this.)
[bookmark: _Toc202782849][bookmark: _Toc208162253]Manual Installation
[bookmark: _Hlk202523520][bookmark: _Hlk37858630]The manual installation of the Kanban Task Manager Sandboxed solution is performed with a WSP file that is downloaded from the kalmstrom.com website. The WSP file is uploaded to a SharePoint Solutions gallery and activated there. After that, the Kanban Task Manager feature must be activated on the site, and on any subsites where it should be used, as described below. 
[bookmark: _Toc208162254]SharePoint Online
If you want to use the Sandboxed solution in SharePoint Online, custom scripts must be allowed in the site during installation and upgrade. This is done in the SharePoint Admin center >Active sites >the sites Details pane >Settings, by a Global or SharePoint administrator.
[bookmark: _Toc208162255]SharePoint On-Premises
If you use SharePoint on-premises and have problems with the activation, please make sure that the Sandboxed code service is running on the SharePoint server.
[bookmark: _Toc201399059][bookmark: _Toc208162256]Upload to a Solutions Gallery
1. Go to the root site of the SharePoint site collection where you want to use Kanban Task Manager and click on the Settings icon in the top navigation bar.
Select the Site settings option or select Site information and then Site settings.
(If you dont see these options, most likely you dont have the appropriate permissions. You need to be Site admin to install solutions.) 
Under Web Designer Galleries, click on Solutions.
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Click on the Upload Solution button and browse to the WSP file you downloaded from kalmstrom.com. 
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When the file has been uploaded, you will be shown a dialog where you can activate the solution for the site collection and make Kanban Task Manager is available for the site and any subsites.
[bookmark: _Toc201399060][bookmark: _Toc208162257]Activate for a Site
Before Kanban Task Manager can be used, the solution must be activated on each site or subsite where you want to add the Kanban Task Manager page. Note that you need to activate Kanban Task Manager this way if you want to use the solution on the root site of the site collection, even though you activated it when you uploaded.
1. Click on the settings icon in the top navigation bar and click on Site settings. You might need to first click on Site information.
[image: C:\Users\sonal\Desktop\Sonal-Backup\KTMSP_PPT\2013-screenshots\96.png]Click on Manage site features under the Site Actions heading. (If you dont see this option, most likely you dont have the appropriate permissions. You need to be at least Site owner to manage site features.)
Find Kanban Task Manager in the list of Site features.
Click on the Activate button to activate the Kanban Task Manager feature.
The activation adds a Kanban Task Manager link in the site settings. Klick on it to open the Kanban Task Manager page. 
[bookmark: _Toc202782850][bookmark: _Toc208162258]PowerShell Package
[bookmark: _Hlk202615058]The PowerShell script is most useful when you want to automate the process of installing Kanban Task Manager in multiple sites. This edition comes as a ZIP file that includes a PowerShell script, which must be modified for each organization before it is run. The PowerShell package works in both Online and On-premises SharePoint.
The changes that must be made for each organization are explained in the script, and the demos on the download page shows the process, but you should still have some experience of PowerShell to use this installation method. 
It is the same script for all SharePoint editions, but note that SharePoint Online only supports PS7, which does not work with PowerShell ISE. 
1. Open PowerShell ISE or Visual Studio Code as an administrator.
Open the .ps1 file included in the downloaded .zip file.
Modify the script:
Change to your SharePoint version if necessary.
[bookmark: _Hlk202529719](For SharePoint Online, add your Client ID.)
Include the sites where you want to install Kanban Task Manager.
Connect to your farm or tenant.
Run the script. 
Now the script installs Kanban Task Manager in each site that has been added to the script. 
Click on the Kanban Task Manager link in the site settings to open the kanban board page.
[bookmark: _Toc202782851][bookmark: _Toc208162259]Example Data for Evaluators
If you are new to Kanban Task Manager, it might be a good idea to load the example list. It gives you an opportunity to see how Kanban Task Manager works when you have many items in a list, what performance you can expect and so on. Example data is available in all the supported languages.
To create example data, open the Example Data tab in the Kanban Task Manager settings and select number of tasks. 
By default, all boxes are unchecked under the Example Data tab. Select number of tasks and check all boxes – or just some of them if you want a simpler installation. Your choices will be reflected in the example data and in the Kanban Task Manager configuration.
When you click OK, Kanban Task Manager starts creating the example tasks. 
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The Kanban Task Manager kanban view opens when the example data has been created.
[bookmark: _Toc7436851][bookmark: _Toc136005826][bookmark: _Toc208162260]Remove Example Data
If you have tried Kanban Task Manager in a test site, you can just remove the whole site. 
[bookmark: _Toc266799457]However, if you have created Example data and want to use the same Kanban Task Manager installation in production, or if you simply want to start over, you can remove the KTM Tasks list in the same way as you remove other SharePoint apps: open the Site contents, select the list and delete it, or open the list settings and delete the list from there.
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The next time you open Kanban Task Manager, the KTMTasks list will be created again.
[bookmark: _Toc208162261][bookmark: _Toc266799446]The Kanban Task Manager Settings
The Kanban Task Manager settings can be opened from all views via the settings icon.
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In the settings, the admin specifies how the kanban board should work for the current Tasks list and how the visualized tasks should look. Click Save to confirm your selection or Cancel to abort it with the buttons in the bottom right corner of the settings. The page will be refreshed automatically when you save the settings, so that you can see any modification immediately.
The settings are organized under tabs, where the values are entered in a grid. Each grid has an empty row at the bottom, and when you type something there and press Enter, a new row will appear.
When you have changed something in a cell, move to the next cell before you save the new setting.
Right-click on the number to the left of an entry in the first column under each tab to show a small context menu.
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If your organization does not need some of the features, do not fill out any information under the corresponding Settings tab. 
The images below show the settings when example data has been created. The Tasks list is called KTM Tasks, and it has the default column names (= the task Status values, see 5.2 below). 
[bookmark: _Ref354161090][image: A screenshot of a computer

AI-generated content may be incorrect.] The Registration tab will be hidden once Kanban Task Manager has been registered. Premium copies of Kanban Task Manager do not have to be registered, so they have no Registration tab. 

[bookmark: _Toc7436869][bookmark: _Toc136005841][bookmark: _Toc208162262]Change Column Captions
[bookmark: _Hlk38460824]The captions of the Settings tabs "Project", "Status", "Assigned To" and "Lane" can be replaced with any other captions that better suit the organization. 
Open the Tasks list(s) you are using with Kanban Task Manager. Open the list settings from the ribbon and click on "Project", "Status", "Assigned To" or "Lane" under Columns. In the Edit Column page, change the column name and click OK.
[bookmark: _Toc208162263]Phase
The different phases in the work process are by default defined with the SharePoint options for task status: Not Started, In Progress, Waiting on someone else, Deferred and Completed. 
To edit the default options, click on a phase name in the Kanban Task Manager settings and type in your own name instead. You can also add more phases here, hide phases from the kanban board and set their sequence on the kanban board. There are also other settings:
[bookmark: _Toc208162264]Percent Completed
By default, the Completed phase has the setting 100 percent completed, which means that closed tasks are moved automatically to the Completed phase. Under the Status tab you can change that setting and also set default percent completed for other phases.
[bookmark: _Toc208162265]Hide a Phase
By checking the Hide option for a phase, you may hide that phase from the Kanban view. It is often suitable to hide the "Completed" phase, which you want to keep for statistics but not display on the kanban board.
[bookmark: _Toc136005834][bookmark: _Toc208162266]Work in Progress
The Work in progress sets a limit for the allowed number of tasks in the phase. The Work in progress setting is not a hard limit. It does not stop users from creating new tasks in or moving existing tasks to the phase when the limit has been reached, but the phase name will be displayed in red, as a warning to indicate that a business rule has been broken.
[image: ]
[bookmark: _Toc7436863][bookmark: _Toc136005833][bookmark: _Toc208162267]Columns Per Phase
If the installation has few phases and you use big screens, you can set one or more phases to have more than one column of tasks. This can be done for all phases, and you can have up to 9 columns in a phase. 
Here, we have set the In Progress phase to have three columns.
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[bookmark: _Toc7436861][bookmark: _Toc136005835][bookmark: _Toc208162268]Project
Under the Project tab, you can enter project names to be selected in the tasks. When projects are finished, they can be hidden under this tab, and if you have selected to color code the projects, which is done under the Other tab, you can change the colors here. You can also decide in which order the projects should be displayed in the task form dropdowns.
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[bookmark: _Toc208162269][bookmark: _Toc136005837]Assigned 
When Kanban Task Manager first is used, all users of the SharePoint site are automatically listed under the Assigned tab. By default, each person or group has a specific color. 
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People can be removed or added in the grid. You can also add assignees to the Assigned tab from the SharePoint form. Start writing and then select the person or group you wish to add.
People or groups can also be hidden from the Assigned dropdown in the Kanban Task Manager task form. When you remove a person's SharePoint account, that person is also removed from Kanban Task Manager.
[bookmark: _Toc136005838][bookmark: _Toc208162270]Multiple Assigned
When a task is assigned to multiple people, a multiheaded icon is displayed on the card on the kanban board, instead of the photo or the initials of a single assigned. In the Timeline view, such tasks are sorted after the first assigned. By default, multiple assigned is allowed in Tasks lists, but that can be changed in the list settings.
In the Tasks list settings, you can disallow multiple assignee choices. In that case, there are no checkboxes at the names and no OK button in the task form dropdown, so only one name can be selected.
[bookmark: _Toc136005839][bookmark: _Toc208162271]Assign External Users
When external sharing is allowed in the site, tasks can be assigned to externa users as soon as they have accepted an invitation to the site.
[bookmark: _Toc7436868][bookmark: _Toc136005840][bookmark: _Toc208162272]Lane
You don't need to use lanes on the kanban board, but if you want to group the tasks in swim lanes, enter at least two lane names under the Lane tab. Add a sequence number to get them in the correct order. 
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You may set Work in progress limits on the lanes, in the same way as with the status phases. 
[bookmark: _Toc7436853][bookmark: _Toc136005842][bookmark: _Toc208162273]Extra Field
Use the Extra field when you want to create a custom parameter to be added to the kanban cards and task form. When you have added a custom field, users can select values for that parameter in the task form, and the tasks can be filtered by those values. 
If you use the Extra field, the Settings tab will have the name you choose, instead of "Extra field".
[image: A screenshot of a computer

AI-generated content may be incorrect.]
[image: A screenshot of a computer

AI-generated content may be incorrect.]When a custom field is used, its value will be displayed in the bottom left corner of the task card, instead of the Due date. In the Kanban Task Manager example data we have chosen the parameter Directions and the values North, South, East and West, but you can set any caption and values that suit your organization.
In the image to the right, the organization has opted to use the parameter "Customer".  The value selected in the task is the customer name Chris Amey.
Enter any parameter name in the Description field under the Extra field tab and enter your values. 
If you want to change the name of the custom field, write another name in the Description field under the Extra field tab (and change the values if needed). 
[bookmark: _Toc136005845][bookmark: _Toc208162274]Actions
An action changes multiple properties of a task at the same time. 
For example, if you add the action "needs research" as shown in the image below, you can specify that it should be assigned to a specific person, placed in a specific lane and postponed for 7 days. When a user then selects the "needs research" action for a task, these three pro-perties will be changed automatically.
[image: ]
Give the action a name and select or type in the values you want to give the task when the action is selected in the Kanban Task Manager task form or from a context menu. 
As the action will be used for a longer period the due date value cannot be given with a date. Instead, it is given with the number of days from the current day.
Actions are added to the context menu and to a dropdown in the task form.
The Save checkbox decides what will happen when the defined actions have been performed on the task. It works differently depending on if the command is executed from the context menu or from the task form.
If the task form is open and the Save box is not checked, the form will remain open.
If the task form is open and the Save box is checked, the form will be saved and closed.
If the command is executed from the context menu and the Save box is not checked, the task form will open. 
If the command is executed from the context menu and the Save box is checked, the task form will not open. 
[bookmark: _Toc208162275]Other
The image below shows the default settings under the Other tab. Check the boxes if you want to use Time logging and/or Checklist, and choose the radio button for color that you prefer.
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[bookmark: _Toc7436856][bookmark: _Toc136005828][bookmark: _Toc208162276]Colors
[bookmark: _Toc7436857]Colors in the different Kanban Task Manager views are by default associated with the assigned person. When you have projects, you may instead let each project have its own color. 
Click on the color you want to change, to replace the default assigned/project colors.
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The grey border around the selected color in the Color column will disappear when you save the settings.
[bookmark: _Toc7436858][bookmark: _Toc136005829][bookmark: _Toc208162277]Checklist
To make it easier to work with large tasks, users can add checklists to them. Users can manage each checklist in the task form, while creating or editing a task. This feature is disabled by default.
[bookmark: _Toc7436859][bookmark: _Toc136005830][bookmark: _Toc208162278]Time Logging
Keep track of how long users have worked on a task with the help of time logging. Users can manage the time logging in the task form, while creating or editing a task. This feature is disabled by default.
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[bookmark: _Toc7436902][bookmark: _Toc136005831][bookmark: _Hlk2702171]Each user enters how many minutes he or she has worked with the task, and the time is automatically summarized and shown to the right of the grid. User and time are entered automatically.
[bookmark: _Toc208162279]Edit or Delete Time Log Entry
If users make mistakes, the time log entry can be edited or deleted in the SharePoint task form. It can also be edited or deleted in the Tasks list associated with Kanban Task Manager.
[bookmark: _Toc7436872][bookmark: _Toc136005846][bookmark: _Toc208162280]Custom Columns
You can add any custom columns that you wish to the Tasks list. They will be shown in the SharePoint form but not yet in the Kanban Task Manager form. That might come in a later version if so requested.
[bookmark: _Toc208162281]Registration for Standard Subscribers
This information is only valid for organizations with a Standard Subscription. Premium Subscribers do not need to register their installations, so there is no Registration tab in the Premium copies.
Register Kanban Task Manager by clicking the Registration button under the Registration tab in the settings. Here, you can also see how many days are left of the evaluation period.
[image: A screenshot of a computer

AI-generated content may be incorrect.]
The person who registers the Kanban Task Manager should have Owner permission on the site. Each site installation needs to be registered. 
Add an e-mail address with the domain name of your company/organization and the registration key you have received from kalmstrom.com.
[bookmark: _Toc201847361][bookmark: _Toc203206556][bookmark: _Toc208162282][bookmark: _Toc50208439][bookmark: _Toc141783042][bookmark: _Toc172735948][bookmark: _Ref323115093][bookmark: _Toc354151881]Upgrade and Removal
We have made our utmost to make the Kanban Task Manager upgrade process easy and quick, and we also want the removal process to be smooth if your organization should decide not to use Kanban Task Manager anymore.
[bookmark: _Toc203206557][bookmark: _Toc208162283]Upgrade
Upgrades are free for all subscribers to kalmstrom.com products, and we recommend that you always use the latest version of Kanban Task Manager. That is the only version we support, so we have made our utmost to make the upgrade process easy and quick. 
Premium subscribers will have an e-mail when their unique copies of Kanban Task Manager have been updated. Standard subscribers can download the new version of Kanban Task Manager from the kalmstrom.com website. At major updates, we will send an e-mail also to Standard subscribers.
You can see all the revisions and file numbers at:
https://www.kalmstrom.com/products/TaskManager/RevisionsSP.htm 
[bookmark: _Hlk59878970]The Sandboxed solution och PowerShell package use the same folders, so you can very well upgrade the Sandboxed solution installations with the PowerShell script and vice versa.
The ​SPFX editions are different, so you cannot upgrade these installations with a Sandboxed solution .wsp file or PowerShell script, and vice versa.
If you still have the old version after upgrade, it is probably left in your browser cache. Please clear the cache to solve that problem.
[bookmark: _Toc40895399][bookmark: _Toc201847362][bookmark: _Toc203206558][bookmark: _Toc208162284]Upgrade the SPFX edition
All the tenants installations of Kanban Task Manager will be upgraded automatically when you add the new SPPKG file to the app catalog.
1. Download the file.
2. Remove the old Kanban Task Manager file from the app catalog.
3. Upload the new SPPKG file to the app catalog. 
4. In SharePoint Online, enable the SPPKG file in the way you prefer. In SharePoint On-premises, deploy the file.
5. All Kanban Task Manager installations will now be upgraded automatically.
[bookmark: _Ref458456458][bookmark: _Toc201847363][bookmark: _Toc203206559][bookmark: _Toc208162285]Upgrade the Sandboxed Solution Manually
To upgrade Kanban Task Manager, replace the old Kanban Task Manager WSP file with a new version of the file. This is the upgrade process for each site collection where Kanban Task Manager is used: 
1. Deactivate and remove Kanban Task Manager under Site settings >Solutions in each (root) site where it is used.
2. Delete the Kanban Task Manager files in the Site Assets library. 
3. Upload the new Kanban Task Manager WSP file to the Solutions gallery and activate it.
4. Activate Kanban Task Manager under Manage site features on each site.
SharePoint Online: custom scripts must be allowed in the site before you upgrade Kanban Task Manager with the WSP file.

[bookmark: _Toc201847364][bookmark: _Toc203206560][bookmark: _Toc208162286]Upgrade with a PowerShell Script
Use this upgrade method whether you have installed Kanban Task Manager with the PowerShell script or with the WSP file and want to upgrade using PowerShell.
1. [bookmark: _Hlk202533281]Open the new Kanban Task Manager script in PowerShell ISE or Visual Studio Code. 
1. Modify the script so that it suits your installations. This is quickly done if you have saved the part of the old script that contains the sites where Kanban Task Manager was installed.
1. Run the script to upgrade the installations in all sites that are included in the script.
[bookmark: _Ref430890377][bookmark: _Toc203206561][bookmark: _Toc208162287]Remove Kanban Task Manager
We of course hope that you will be satisfied with Kanban Task Manager, but if you want to remove it from a site that is an easy process.
If your organization cancels the Kanban Task Manager subscription, the product must be removed in all sites. The Tasks list will not be removed if you delete the Kanban Task Manager installation files.
To remove the Kanban Task Manager SPFX edition, remove the file from the App catalog/Apps site. The web part will still be left in the pages where it has been used. If you dont remove it, these web parts will be populated if you install Kanban Task Manager again.
To remove the Kanban Task Manager Sandboxed solution WSP installation, follow step 1-2 in the Upgrade instruction above.
To remove Kanban Task Manager with a PowerShell script, run the parts of the script that remove Kanban Task Manager. 

[bookmark: _Toc266799493][bookmark: _Toc208162288]Support
To use Kanban Task Manager, you must have a valid subscription. Free upgrades and the kalmstrom.com Support Services are included in all subscriptions. Support is also free for evaluators, and we welcome all communication.
[bookmark: _Toc266799494][bookmark: _Toc208162289]Contact
The solutions of kalmstrom.com are designed to be very easy to deploy, use and manage. However, if you have any kind of problems or questions about our software, there are several ways of contacting us:
	E-mail
	support@kalmstrom.com
	Technical issues

	 
	sales@kalmstrom.com
	General and sales issues

	
	finance@kalmstrom.com
	Subscription issues

	Teams
	peter@kalmstrom.com
	

	Zoom
	peter@kalmstrom.com
	

	Telephone
	+46 739 206 106
	


[bookmark: _Toc208162290]More SharePoint Tips
You surely have noticed that Kanban Task Manager uses what is best in SharePoint. For tips on SharePoint usage in general, please refer to the Tips section of the kalmstrom.com website.

[image: ]Kanban Task Manager for SharePoint V11 Manual    www.kalmstrom.com
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